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Using Snow Leopard’s System Preferences we can adjust the appearance and behavior of Macs to enhance 
accessibility for many vision, hearing, mobility and learning impaired users without additional software or 
hardware. 
 

Visual Accommodations 
Vision problems, ranging from slight impairments to blindness, can impede full computer access. System level 
options built into Snow Leopard allow for larger fonts, icons, buttons, menus and toolbars and speech output. 
 
System Modifications 
 
Change screen resolution- Smaller resolution numbers result in larger screen objects. 

System Preferences:Displays:Display- Choose 800 x 600 or 640 x 480 for largest screen items. 
 

Reduce background clutter- Pick a solid desktop pattern. 
 System Preferences:Desktop&Screen Saver:Desktop- Choose one under Desktop Pictures /Solid Colors. 
 
Change the background color in folders- Some users may prefer colors other than white when viewing files. 
 Click inside the folder. Select ‘Show View Options’ from View Menu. Select ‘Color’ at the bottom.   

You can set these settings as a default for ALL folders by selecting ‘Use as Default’. 
 
 Increase size of icons and their names- This could be done in addition to or in lieu of changing the resolution. 

Click on desktop;View Menu:Show View Options- Change icon/text size. Icon size (now up to 512x512)  
can also be changed, while in ‘Folder View’, using the Slider located in the upper right.  

 
 Increase/Decrease the space between objects – Some users need more space around icons to identify targets. 

 Click on desktop;View Menu:Show View Options- Change icon “Grid spacing” slider. 
You can set these settings as a default for ALL folders by selecting ‘Use as Default’. 

 
Increase the size of the Dock- Place often used Applications and Documents in the Dock for easy access. 

Apple Menu:Dock:Dock Preferences: Adjust the Dock size and Magnification according to taste. 
Mouse Down on Dock Runway: Adjust the Dock magnification by moving mouse up and down . 
 

Enlarge the size of the cursor- A user needs to track their cursor, make it bigger but not too big. 
 System Preferences:Universal Access:Mouse & Trackpad- The “Cursor Size” slider adjusts in real time. 
 
Make the display monochrome- Some users with visual impairments prefer white on black text. 
 System Preferences:Universal Access:Seeing:Display- Check “Use grayscale” Adjust contrast if needed. 
 
Magnify the whole screen- If none of the above magnifying modifications work, use the built-in ZOOM. 
 System Preferences:Universal Access:Seeing- Zoom can be turned off/on using keyboard equivalents. 
 Use the Zoom ‘Options’ to customize behaviors. 



                               OR System Preferences:Trackpad/ Select ‘Zoom while holding’ and set ‘Options’ 
Use a screen reader- Snow Leopard includes a built-in, not bolted on, screen reader called VoiceOver.  

System Preferences:Universal Access:Seeing- VoiceOver can be turned off/on using keyboard. 
 Use the VoiceOver Utility to customize behaviors. 

 Use a flash drive to save preferences to use on any          
 Mac with Leopard/Snow Leopard. 

 See http://www.apple.com/voiceover/info/guide/ 
 for more information. 
 

Use audio compression within QuickTime Player- Listening to recorded speech can be tedious if there are 
long pauses between the speaker(s) words or phrases. Speech that has been recorded using GarageBand, 
iMovie or audio recorders can be played back quickly, without pauses or pitch change. Using 
QuickTime Player, hold the Fast Forward (>>) button down. If the user can’t hold the button they can 
use the mouse keys feature (see ‘Use the keyboard to move mouse cursor’ in the physical 
accommodations section) to lock a Mouse Down action over the Fast Forward (>>) button. 

 
De-clutter text on Safari web pages- Users are able to extract a text-only view of certain web pages. If an 

article is available to convert, the user can click on the ‘Reader’ button- next to the re-
load page icon in the address field. Moving the mouse to the bottom-center of the page a 
user can Zoom in and out,  email or print the clean text version. 

 

Hearing Accommodations 
By providing visual prompts to audio alerts, students with hearing impairments attention problems will be 
aware of auditory cues. 
 
System Modifications 
 
Flash the screen when an alert sound occurs- Flashes the screen when an alert sound occurs. 
 System Preferences:Universal Access:Hearing- Select ‘Flash the screen when an alert sound occurs’ 
 
Play stereo audio as mono- Converts audio to monaural to support users with unilateral hearing loss. 
 System Preferences:Universal Access:Hearing- Select ‘Play stereo audio as mono’ 
 
Show captions in QuickTime when available- Be sure you have at least QuickTime v. 7.4. Videos from the  

iTunes store with Closed Captions will be identified with “CC”. Users can now do ‘Power Searches’ to 
isolate movies with Closed Captions only. When in the QT Player, go to the View menu and select 
‘Show Closed Captioning’.  

 
Use iChat to communicate with others in Sign Language- Open iChat, enter your AIM, mac.com or  

MobileMe account name. AIM (AOL Instant Messenger) accounts are free. Add the other User to your 
buddy, family or co-worker list. Initiate your video chat by clicking on the camera icon next to the 
User’s name. You can videoconference with PC users if they have AOL Instant Messenger (AIM) 6.1 or 
higher. ‘Skype’, ‘SightSpeed’ or other cross-platform applications could also be used. 

 
Use iChat to make free ‘Relay’ phone calls to landlines and cell phones- Open iChat, enter your AIM,  

mac.com or MobileMe account name. AIM (AOL Instant Messenger) accounts are free. Add the name 
HovrsIM (Hands On Video Relay Service Instant Messaging) to your buddy list.  
Select HovrsIM and type the message “hello”.  There is also a HovrsWidget available for Dashboard. 



Physical Accommodations 
The inability to access a keyboard and mouse is common for users with physical disabilities. Customizing the 
system makes it easier for students with physical disabilities to control the computer. 
 
System Modifications 
 
Page down in Safari or Pages documents by voice- Allows a user to go to the next page or scroll though long      

   web pages using their voice.  
 System Preferences:Speech:Speech Recognition:- Set your Microphone and Listening Method. Select  
     ‘Calibrate’ to improve recognition and test some spoken commands. 
 
Control the computer with one finger- Allows computer access with one finger, headstick or mouthstick. 
 System Preferences:Universal Access:Keyboard- Select Sticky Keys.  Display pressed keys on screen. 
 
Slow down key acceptance- Puts a delay between when a key is pressed and when it is accepted. 
 System Preferences:Universal Access:Keyboard- Select Slow Keys On, use Acceptance Delay slider. 
 
Turn off Key Repeat- A no-brainer. Unless the user is playing an arcade game, turn off the Key Repeat. 
 System Preferences:Keyboard & Mouse/Key Repeat Rate- Adjust with slider. 
 
Create Keyboard Shortcuts- If user’s preferred input is the keyboard, stay on the keyboard. See Sticky Keys 
 System Preferences:Keyboard & Mouse:Keyboard Shortcuts- Use the + to add new Shortcuts. 
 
Allow for full keyboard access- Allows the user to navigate windows/dialog boxes with the keyboard. 
 System Preferences:Keyboard & Mouse:Keyboard Shortcuts- Select Text boxes and lists or All controls. 
 
Navigate the computer using the keyboard- Select and open folders and applications by typing letters, Tab  

moves forward alphabetically, shift-Tab moves backward alphabetically Command-‘O’ will open the 
selection. 

 
Navigate the computer using the keyboard and Spotlight- Select ‘Command-Space’ to bring up Spotlight.  

Type the first few letters of any application, document, or text within a document. Found items are 
organized by type. Applications are listed first. Use the arrow keys to move. Press ‘Return’ to select. 
Use ‘Sticky Keys’ for one finger, headstick, mouthstick or on-screen keyboard access. 

 
Use the keyboard to move mouse cursor- If user is proficient with one digit or stick, they can mouse around. 
 System Preferences:Universal Access:Mouse & Trackpad- Turn Mouse Keys ON.  

Control speed with Delay and Speed sliders. 
 

Use QuickTime Player & built-in Mic and/or Camera- Students can record homework/reports/tests as audio  
         or video files without purchasing extra software.  

Open QuickTime Player - Select ‘New Audio Recording’ or ‘New Movie Recording’ from the File menu.  
For even more fun have students record video reports using free Mac software. Open ‘Photo 
Booth’, press the right ‘Effects’ arrow three times to get to the ‘User Backdrops’. Drag and 
drop digital stills or videos clips of your own or from the Internet to provide a relevant static 
or video backdrop for the student’s report. 

 
 
 
 
 



Enlarge the size of the cursor and the targets- The larger the target and cursor the easier to track and select. 
 System Preferences:Universal Access:Mouse & Trackpad- The “Cursor Size” slider adjusts in real time. 

System Preferences:Displays:Display- Choose 800 x 600 or 640 x 480 for largest screen items. 
Open folder- Change Icon size (now up to 512x512) using the Slider located in the upper right corner.  

 
Slow down the mouse double-click- Most impaired mouse users have trouble with double clicking. 
 System Preferences:Mouse/ Set Double Click Speed with slider. 
 
Set Scroll Bar behavior-  It’s easier for most users to have scroll arrows next to each other for easier control. 
 System Preferences:Appearance- Place scroll arrows Together. 

 
 

Set Scroll Bar behavior-  Clicking on the Scroll Bar can be adjusted to jump to the next page or to a  
        page in the document in proportion to the Scroll Bar. 

           System Preferences:Appearance- Select ‘Jump to the next page’ or ‘Jump to here’. 
 
Use an on-screen Character Palette- To type math and other symbols not found on a typical keyboard. 

System Preferences:Keyboard - Check ‘Show Keyboard & Character Viewer’, select ‘Show Character  
   Viewer’ on the menu bar, to the right of the day & time. 

 
Use an on-screen keyboard- To experiment with mouse or head mouse if the user has fine motor control. 

System Preferences:Keyboard - Check ‘Show Keyboard & Character Viewer’, select ‘Show Keyboard  
   Viewer’ on the menu bar to the right of the day & time. 

The keyboard is movable and now resizable AND compatible with ‘Sticky Keys’. 
 
 
Use a different keyboard layout- Some students may prefer a Dvorak, or Dvorak- Qwerty Command, or Left  

            Hand or Right Hand Dvorak. The last two returning to Snow Leopard after  
            disappearing from Leopard. The Dvorak- Qwerty Command keyboard  
            toggles between Dvorak and Qwerty for command-key shortcuts. 

System Preferences:Keyboard - Check ‘Show Keyboard & Character Viewer’, select ‘Show Keyboard  
  Viewer’ on the menu bar, to the right of the day & time. Select       
  preferable keyboard. 

 
Use and inexpensive graphics tablet and Ink- Students who have MD or limited hand/arm movement AND  

can still form letters, but unable to move their hands across the paper are able to write in one place and 
conserve their energy. No assistant needed to slide their paper, no maneuvering on a small keyboard, no 
mousing around an on-screen keyboard. Just using what the already know, handwriting, and some 
additional gestures to add spaces, returns, cutting and pasting etc. 
System Preferences:Ink- Adjust setting as needed. 
    ‘Ink’ will only appear after a graphics tablet in connected. 



Accommodations for Learning 
Some users with learning differences need extra support to complete computer and school tasks. Snow Leopard 
has built-in features that help users read, look up definitions and use a talking calculator for math and data 
conversions. 
 
Find ANY text in your hard drive using Spotlight- Users who forget what name they saved as can find their  

documents.  Select ‘Command-Space’ to bring up Spotlight. Type the first few letters of any 
application, document, or text within a document. Spotlight now supports Boolean logic searches. Found 
items are organized by type. Applications are listed first. Use the arrow keys to move. Press ‘Return’ to 
select. 

 
Set the computer up to read text- Users are able to select words, phrases, or whole texts to read aloud. 
 System Preferences:Speech:Text to Speech- Select your System Voice & Rate.   

ALEX rocks, listen to him take breaths while reading. 
Select ‘Speak Selected Text when the key is pressed.’ 
You can re-set the HOT key that triggers the speech. 
You can buy other voices from AT&T and Cepstral. 
Text can be typed, downloaded or scanned in.  
‘Kurzweil 3000’, ‘Read OutLoud’ or ‘Read & Write’ by 
TextHelp can be used to both scan and read text. 
 

De-clutter text on Safari web pages- Users are able to extract a text-only view of certain web pages. If an 
article is available to convert, the user can click on the ‘Reader’ button- next to the re-
load page icon in the address field. Moving the mouse to the bottom-center of the page a 
user can Zoom in and out,  email or print the clean text version. 

 
Create iTunes, and CD audio files from ‘iWork, ‘Mail’, TextEdit, Safari web sites or other Cocoa Apps. 

Students, teachers and administrators can convert any text from most every Cocoa App into a text-to-
speech file in 3 steps. (1) Select text to be converted (2) From the ‘Services’ Menu select ‘Add to iTunes 
as a Spoken Track’. You can use a short-cut by Control-Clicking or Clicking with 2 fingers on the track-
pad or Right-Clicking on the selected text and selecting ‘Add to iTunes as a Spoken Track’ from the 
contextual menu. (3) Wait for the audio cue and re-name the recording when iTunes appears. 

System Preferences:Keyboard- Keyboard Shortcuts- Select ‘Services’ from the left-hand menu and put a  
         check next to ‘Add to iTunes as a Spoken Track’. The default voice is  

   set in the ‘System Voice’ located in the ‘Speech’ System Preferences. 
 

Or  Open ‘iWork, ‘Mail’, TextEdit or Safari. Select the application’s menu     
   found at the immediate right of the ‘Apple’ menu.  
 Select the ‘Services’ menu item and then select the sub-menu ‘Services    
 Preferences…’ at the bottom.  
 Select ‘Services’ from the left-hand menu and put a check next to   
‘Add to iTunes as a Spoken Track’ in the right-hand menu. 

 
 

 
 
 

 



Use audio compression within QuickTime Player- Listening to recorded speech can be tedious if there are 
long pauses between the speaker(s) words or phrases. Speech that has been recorded using GarageBand, 
iMovie or audio recorders can be played back high speed without pauses or pitch change. Using 
QuickTime Player, hold the Fast Forward (>>) button down. If the user can’t hold the button they can 
use the mouse keys feature (see ‘Use the keyboard to move mouse cursor’ in the physical 
accommodations section) to lock a Mouse Down action over the Fast Forward (>>) button. 

 
 
Use the dictionary shortcut in TextEdit, Safari, iWork– Users can bring up definitions using Hot keys. 

Use the Control, Open Apple and D keys to view definition. You can even move the cursor to 
different words while holding just the ‘Control’ and ‘Apple’ key. Select the ‘More” button on the 
lower right corner brings up the dictionary app. The user can now select any text and have 
definitions read back. The dictionary can also be brought up as an application or widget. 
 

Use the word completion shortcut in TextEdit, Safari, iWork and other aware applications - Use the  
Escape keys to view a list of possible word completions.  
 
 

Provide automatic Abbreviation-Expansion using the Text substitution/Auto-correct feature found in 
TextEdit and other aware applications – Users can develop their own codes and/or enter appropriate  

         Internet acronyms to make typing faster and conserve keystrokes. 
System Preferences:Language & Text- Select the Text tab. Click the ‘+’ sign in the lower left to add.  

  
 

Use QuickTime Player and built-in Mic and/or Camera- Students can record homework/reports/tests as 
audio or video files without purchasing extra software.  
Open QuickTime Player- Select ‘New Audio Recording’ or ‘New Movie Recording’ from the File menu.  

For even more fun have students record video reports using free Mac software. Open ‘Photo 
Booth’, press the right ‘Effects’ arrow three times to get to the ‘User Backdrops’. Drag and 
drop digital stills or videos clips of your own or from the Internet to provide a relevant static 
or video backdrop for the student’s report. 
 

 
Use QuickTime Player and built-in Mic and/or Camera- Archive your student’s reading fluency/articulation  

        as audio/video files without buying extra software.  
Open QuickTime Player- See above. 
 
 
Use QuickTime Player with Free Screen Recorder- Archive your student’s technology/educational skills by  

  recording their computer screen actions w/without audio.  
Open QuickTime Player- Select ‘New Screen Recording’ from the File menu. Options for- Audio source, Video  

     quality and ‘Save to’ can be found under the triangle in the lower right of the ‘Screen  
     Recording Window’ After recording you will have the option to trim the beginning/    
     end of your video and the ability to export to your MobileMe Gallery, YouTube  
     or iTunes for iPod/iPhone or CD playback. 
 

 
Use QuickTime Player with Free Screen Recorder- Create your own video lessons for playback on computer,  

    iPod/iPhone or internet w/without audio narration.  
Open QuickTime Player- See above. 
 



Use Calculator for math and conversions- The Calculator is found in the OS X Applications folder.  
 The Calculator can be set to keep a paper tape trail. 

     The Calculator can be set to Speak the Button Pressed. 
 The Calculator can be set to Speak and Print the Result. 
 The Calculator can convert Area, Currency, Temperature, etc. 
 

Use label colors to differentiate between documents and folders- You can change the label color of any Icon. 
To change any label, select the icon with one click. Under ‘File’ select ‘Get Info’.  
Click on the expansion triangle next to ‘General’ if closed.  
OR Right Click/Control Click on a label or icon 
Under Label: select one of 8 colors.  

 
Use pictures/photos to differentiate between documents/folders/internet sites- Change the image of an icon. 

To change any icon, select an image you want to use and copy it. Select the icon you want to change 
with one click, then under ‘File’ select ‘Get Info’. Click on the icon in the upper left corner and ‘Paste’. 
 
For internet sites- 1) Take a screenshot of an identifying portion on the web page using Shift-control-

Command-4. 2) Drag the URL address to the desktop or folder. 3) Select the icon you want to change with one 
click, then under ‘File’ select ‘Get Info’. Click on the icon in the upper left corner and ‘Paste’ the new image. 

 
Use Cover Flow and Top Sites to allow struggling readers to locate folders, documents and Internet sites-  

‘Cover Flow’ can be selected from the View menu while in the Finder. Replace all generic icons with 
representational graphics/photos. ‘Top Sites’ is a Safari web browsing optional view that is located 
under the Right Arrow in the upper left corner. Its icon is a 3x4 matrix of small squares. 

 
Have the most used application pre-loaded at boot-up-  

System Preferences: Accounts –Be sure user has administrative permission. Select Login Items, select  
        the + to add the application you want to pre-load when the user logs in. 

                                     
OR  Login as the User you want to set up. Be sure User has Administration 

permission, even if temporary. Place the applications you want to pre-
load in the dock. Select each application from the Dock. Wait a few 
seconds. 

 Select Options:Open at Login from the pop-up menu. 
 
Limit the access to specific programs and monitor use- Similar to Edmark’s ‘KidDesk’ or Apple’s‘At Ease’. 

System Preferences: Accounts, Parental Controls- Select from top Tabs or set controls and/or keep logs. 
 

Set-up User for the Simple Finder- Dock will contain 3 folders: My Applications, Documents, and Shared.  
 System Preferences: Accounts, Parental Controls- Create a new or select an existing managed user. 

               Select allowable Applications, Printer/Burning of 
CD/DVD access and permission to change password. 

              Refer to the System’s ‘Help’ for more info on setting 
timers and Internet/Mail/iChat restrictions and Logs. 

 
Lock your screen with one click when away from computer- Compare to ‘Window Key + L’ in XP. 

Open the Keychain Access program. Under the Keychain Access menu select ‘Preferences…’ Check 
‘Show Status in Menu Bar’. You will now have a small Lock icon in your menu bar.  
 The first item will be ‘Lock Screen’. You will need to enter your password to unlock your system. 
 

Recover files to their original location when accidentally deleted by user or student-  
 Control-click or Right-click on the file in the Trash. Select ‘Put Back’ from contextual menu. 


